
Support and Services

If you are experiencing problems or getting unexpected results using HiJaak Express, the 
Troubleshooting, Tips and Tricks help might help you find a solution. To get help, click on the following:

Troubleshooting HiJaak Express

If you encounter problems you are unable to solve through the use of online Help, printed manual, or the 
Troubleshooting Help file, you can call our Technical Support department. Registered users of HiJaak 
Express and other IMSI products are entitled to 3 months of free technical support, starting with your first 
request.

For more information on techncial support, click on the following:

Technical Support



Technical Support

There are many ways to contact technical and customer support. Some of them are available to you 24 
hours a day. Technical Support will work closely with you to solve any problem(s) related to our software. 
Please give our support technicians as much information as possible. Remember that they are not in front
of your computer and that they need your help to diagnose the problem.

On occasion, a problem can be traced to hardware, or to another software application. Our technician will 
supply as much support as possible in these cases, but they are not authorized to support products 
manufactured or published by another company.

You might find that e–mail is a more convenient way to get technical support. You won’t get put on hold, 
and the technician will have time to fully consider your problem and formulate an answer. If you do send 
e–mail, provide as much information as you can about your system and about the problem. Use the check
list from the following section whenever you contact technical support.

Technical Support Check List

To receive the fastest response to your technical questions, please complete the following checklist 
before you call or send e–mail:

· You may already have the information you are looking for. Before calling, check your User Guide 
thoroughly. Let the technician know what you’ve tried.

· Record the exact sequence of events that created the problem. Make sure that you can reproduce the
problem by following the same series of steps.

· Have the name, version number, and file date of the application. To get the exact version number, 
select Help|About HiJaak.

· Know the type of computer and Windows version you are using.

· Record the exact wording of any error messages.

· Know the results of any steps you have undertaken to solve the problem.

· Be in front of the computer, with the computer on.

Electronic Support

Free electronic technical support is available 24 hours a day on the IMSI Web Site. Several product 
support options are available including user forums and Frequently Asked Questions. 

When you reach us via the Web, click on the support icon under the IMSI logo to access the various 
support options. Look for Product Support and Product Support Forums, Inference Knowledge Bases, 
Technical Support Downloads, Software Installation Instructions, On-line Registration Information, and 
Information on How to Contact Customer Support. You can reach all of these from the IMSI Support and 
Service Web page. 

Technical Support



No charge technical support, via a toll call, is available from IMSI. In the United States, Technical Support 
hours are 8 a.m. - 6 p.m. Mountain Time, Monday through Friday, excluding holidays. 

Phone Number +1-505-232-3200

Fax Number +1-505-232-8559

Email Address hijaakxsupport@imsisupport.com

Mailing Address IMSI P.O. Box 3496 Albuquerque, NM 87190-3496

World Wide Web http://www.imsisoft.com

Other Customer Service Options

IMSI also offers sales, support, and service via the phone and Internet.

Please call for pricing, product information or replacement discs, Sales/Customer Service (800) 833-8082

Online Store http://www.imsisoft.com, then click on Purchase



Troubleshooting, Tips and Tricks for Using HiJaak Express

If you are having problems using HiJaak Express, or if you are getting unexpected results, you can find 
possible solutions in this help file. 

Tip: If you are having problems working with a file in HiJaak Express and none of the troubleshooting tips 
and tricks work, try converting the file to another format and trying again.

Click on the feature of HiJaak Express with which you need troubleshooting help:

 Basic Look of an Image
 Catalogs and Updates
 Colors
 Conversions and Formats
 Error Messages
 HiJaak Express and Windows Applications
 Installing and Setting Up HiJaak Express
 Macintosh Files
 Printing
 Rotating
 Scaling and Resizing
 Scanning (HiJaak Scan)
 System Problems
 Text and Fonts
 Viewing





Colors

HiJaak Express Problems With the Colors in an Image
If the colors in your image do not look right, click on the problem below that most closely matches your 
situation:

 The image has strange patterns throughout
 The image is too light or too dark
 The image looks like a photo negative
 Invert colors doesn't seem to be working right
 My black and white print-outs of color images look bad
 My color changes don't appear correctly or colors seem to be changing for no reason
 My grayscaled image looks bad
 Palette Optimization seems to have no effect
 Reverse Black and White seems to have no effect
 When I reduce colors, the image looks bad



The image has strange patterns throughout

Q. Why is there a box-like pattern in my image?
A. Using Dither in HiJaak Express not only "blends" colors from the Windows palette to approximate the 

colors of your original image, but it blends them in a distinct pattern.    If this box-like pattern is very 
obvious, you may want to use Diffuse, which blends colors from the Windows palette in a more 
random pattern. Note that Diffuse takes longer to process.

Q. Why is HiJaak Express's default Reduction Method set to Dither?
A. HiJaak Express uses Dither because it's the quickest way to get the best display of images that 

contain more colors than are available in your Windows palette. Snap is faster than Dither, but the 
results aren't as good.

Q. Why are there "worming" patterns in my image?
A. When using the Diffuse option, this is always a potential problem. Use the Dither option and see if you

get better results. Colors in your image that are not available in your Windows palette must be 
approximated using either Dither or Diffuse patterns. Choose the one which gives you the best 
results.



The image looks too light or too dark

Q. How do I convert a captured screen with a dark-colored background to grayscale and get an 
image that is not too dark?

A. Set Brightness up to +15 or +20 to lighten the image overall.    If only the foreground is too dark, use 
Contrast at about +15 or +20 to lighten the foreground.

Q. How can I lighten the middle-range of colors, while leaving extremely light and extremely dark 
areas alone?

A. To lighten mid-range areas, increase the Gamma Correction. Pull down the Colors menu and select 
Contrast and Brightness (Alt+c, b).    In the Contrast and Brightness dialog box, increase the 
Gamma Correction until the thumbnail looks as you want your image to look (Alt+G). Click on OK.

Q. My image appears to be all approximately the same muddy color.    How can I see the 
differences in the colors more clearly?

A. When the tones represented in your image appear to be basically the same color or colors throughout 
the image, use Histogram Equalization to perform an analysis of the tones and separate them evenly
to produce a clearer-looking image. Pull down the Colors menu and select Contrast and Brightness 
(Alt+c, b).    In the Contrast and Brightness dialog box click on the      Histogram Equalization check 
box (q). Note that this option will have little effect on images in which the tones are already spaced 
evenly.

Q. Why does the color white sometimes appear as a light pattern in my printouts?
A. If you are viewing a 24-bit image, what shows up on your monitor as white may, in fact, be slightly off-

white or a light gray. Because it usually has just black ink or black toner to represent shades, your 
printer must show the light gray as a halftone pattern. The halftone patterns generated on high 
resolution output devices, such as image-setters, will produce good-looking, highly accurate results. 
On lesser resolution devices, it may be necessary to experiment with different brightness setting to 
produce the best printed results.



The image looks like a photo negative 

Q. Why does my displayed image appear as a photographic negative?
A. In certain situations, the color palette is inverted producing the effect of a photographic negative.    Pull 

down the Colors menu and select Invert Colors to restore the proper colors (Alt+c, i).



Invert Colors doesn't seem to be working right

Q. Why is the Invert option switching black and white to other colors instead of reversing them?
A. Invert is used not to reverse black and white, but to invert the entire color palette. Often what may 

appear as black or white on your monitor is actually a dithered pattern of other colors. If you use invert 
on these dithered patterns, each individual color will invert; therefore what appeared as black will not 
appear as white and vice versa. 
Note that if you don't want to invert the entire color palette, but you do need to interchange black with 
white, pull down the Colors menu and select Reverse Black and White (Alt+c, r).

Q. Why does part of my image disappear after I select Invert Colors?
A. If parts of the image are the same color as the background after inversion, this will happen. For 

example, if you invert an image containing black objects on a white background, the black objects will 
become white and will be hidden on the white background. To workaround this problem if the 
background color is white, as in this example, you could try using HiJaak Express’s Colors\Reverse 
Black and White option to change the white objects back to black. If not, change the background 
color HiJaak Express uses by pulling down the Setup menu, select Preferences and setting a 
different Background Color. 



My black and white print-outs of color images look bad 

Q. How do I achieve the clearest possible black and white printout of a color line-drawn vector 
image?

A. Pull down the Colors menu and select All Colors to Black (Alt+c, c); every non-white object in a 
vector image will become black.    A printout will show solid black objects and lines.

Q. How do I get a clear black and white printout of my raster image?
A. If you are printing to a dot matrix or LaserJet printer, in the Print Options dialog box select the 

Grayscale option and click on the Reduce Colors tab.    In the Reduce/Expand Colors dialog box, 
select Number of Colors=2, and a Reduction Method of Snap. HiJaak Express will look at the colors
in the file and determine whether they are closer to white or black and snap each color to either black 
or white.    For instance, yellow is closer to white and will become white.    Blue is closer to black and 
will become black.    If you were to use All Colors to Black instead of the options listed above, you will
most likely get an all black image.    

A. If you are printing to a PostScript language printer, select the Grayscale option, but leave the Number 
of Colors the same using the Snap Reduction Method.

Q. Why does the color white sometimes appear as a light pattern in my printouts?
A. If you are viewing a 24-bit image, what shows up on your monitor as white may, in fact, be slightly off-

white or a light gray. Because it usually has just black ink or black toner to represent shades, your 
printer must show the light gray as a halftone pattern. The halftone patterns generated on high 
resolution output devices, such as image setters, will produce good-looking, highly accurate results. 
On lesser resolution devices, it may be necessary to experiment with different brightness setting to 
produce the best printed results.



 My color changes don't appear correctly, or colors seem to be changing for no 
reason

Q. Why isn’t List Color Changes\Modify working? I changed a color and now I want to modify it, 
but HiJaak Express won’t change anything when I select modify.

A.. List Color Changes is working: Once you have applied the first color change, such as yellow to blue, 
there is no yellow left in the image. Therefore, if you don't reload the original image, your modification 
of the “yellow to anything” change will have no effect, because there is no longer any yellow in the 
current image. If you re-open the original image, modify the color change and click OK (apply should 
already be checked), it should work. 

Q. Why does changing a color in my 24-bit raster image change other similar colors too?
A. This is a feature of the Change a Color option which will change the color you select, as well as 

change similar colors within a certain tolerance.    Because 24-bit images commonly have gradient fills 
that are nearly undetectable, this allows you to change the whole area with only one color change.

Q. Why aren't the colors in my 256 color image viewing properly?
A. If you are using a standard Super VGA graphics card and you are not running Windows in a 256 color 

mode, you will not be able to view an image with 256 colors properly.    Windows cannot supply 
enough colors from its palette for HiJaak Express to view it properly.

          Either select a graphics mode from the Control Panel's Display\Settings that supports 256 colors (if 
your graphics card supports it), or display the image using the Reduction Method of Dither or 
Diffuse in HiJaak Express.    Reduction methods will not display exact colors, but will blend the colors 
available in the Windows palette to produce a more attractive image.

Q. Why does a colored background appear when I rotate an image after using the Optimize Palette
option?

A. When an image is rotated a number of degrees that is not an even multiple of 90, the resulting image 
will no longer fit into the rectangular window available for it. HiJaak Express must pad the image with 
pixels of a certain color to fill out the rectangular window. Whenever possible, HiJaak Express will fill 
out the image with the background color selected under Setup and Preferences. However, if palette 
optimization is used on an image before rotation, the optimization may, in fact, eliminate the 
background color from those available for the particular image. Another background color -- one that is
available in the new optimized palette -- is selected to fill out the image window. To ensure that no 
color substitution takes place, rotate the image before selecting optimize palette. Performing the 
rotation first will introduce the background color into the image and it will be preserved as part of the 
palette through the optimization process.

Q. I've used Change a Color to change color A to color B but then decided to reverse the process 
by using Change a Color to set color B back to Color A. Now whenever I perform any 
processing on my image I see it repaint first in color A then Color B and then Color A again. 
How can I halt this process?

A. Color changes in HiJaak Express do build one upon another. To eliminate the repaints, you must also 
eliminate the color changes that are causing the repaints. Do this by selecting List Color Changes 
from the Colors menu and selecting the Clear button.

Q. Why can't I change colors in my vector images?
A. Color changes in vector image are unpredictable if you are displaying less than 32,000 colors in 

Windows. The unpredicability is due to HiJaak Express's need to create colors using a dithered 
pattern. Try using a display mode with a higher number of colors. You can change the display mode 
using the Control Panel's Display control.



Palette Optimization seems to have no effect

Q. Why doesn't Palette Optimization improve the output image?
A. Palette Optimization only has an effect if you reduce the number of colors in the output image.



Reverse Black and White seems to have no effect

Q. I selected Reverse Black and White and it did not have any effect on my image.
A. Often colors that appear to be black or white are actually not true black and true white.    Reverse 

Black and White only reverses true black and true white.    If this option seems to have no effect on 
your image, you probably don't have any black or white in the image. The colors that appear as black 
and white probably do because your image has more colors than can be displayed; therefore, very 
dark colors will be represented on the display as black, and very light colors will be represented in the 
display as white.



When I reduce the Number of Colors, the image looks bad 

Q. How do I reduce the number of colors and still get an attractive image?
A. If you wish to reduce a 16 million color image to 256 colors, you should use HiJaak Express's different 

palette options to get the best results. Use the Reduction Method of Dither or Diffuse, and select the
Optimize Palette option from your Reduce/Expand Colors dialog box for best results.



My grayscaled images look bad

Q. Is one format better to use for grayscaling?
A. The TIFF format supports entirely grayscale palettes, and so is better when converting to grayscale 

images. Other formats such as PCX must use combinations of black and white to approximate grays.

Q. Why do I occasionally see strange colors appearing in my image when I make it grayscale?
A. The presence of non-gray colors in a grayscale image will occur most often when dealing with 16-color

images or running Windows in a 16-color graphics mode. There may be no grays or few grays in the 
palette available to HiJaak Express in those circumstances. HiJaak Express is forced to substitute 
another available color for the unavailable gray or grays.



Conversions and Formats

For help with conversions and file formats in general, click on the format below with which you need help:

 AI
 CGM
 EMF
 EPS
 FAX
 GEM
 GIF
 ICO
 JPG
 RLE
 TXT

If none of the above topics apply, click on the following:
General conversion problems



AI

Q.      Adobe Photoshop can’t read any of the AI files I create with HiJaak Express. What should I 
do?
A.     When converting a file to AI, select the Options button. In the Processing Options dialog dialog box, 

pull down the Flavors list and select Adobe Photoshop. Click OK and continue with the conversion. 
Photoshop should have no problems reading the files created.



RLE

Q. Why do the file sizes of some RLE files increase when I convert from BMP to this file type?
A. The RLE compression type is effective only when a BMP image has a large number of similarly colored

dots (or pixels) in close proximity to each other. Other types of BMP files may not be compressed at all
when the RLE is selected, and some may actually increase in size.



GIF

Q. How can I make a color other than black or white transparent in my GIF files?
A. If you want to set a color other than black or white to transparent, first use HiJaak Express's Change a 

Color option to change the black or white in the image to a color that is very close. Then, use Change 
a Color to change the color that you want to make transparent to black or white. For example, suppose
you had an image with a blue background that you wanted to make transparent. First, change all black
in the image to dark gray. Then change all blue in the image to black. Then, convert the image to    GIF
and select Black in the Transparency area of the dialog box. For more information on changing colors, 
click on the following:
Change a Color



CGM

Q. Why does my CGM image open with a background color different from the one I have selected 
in Preferences? 

A. All CGM images have background color information built directly into the file. If you open an image like 
this, HiJaak Express will view it with the file specified background color, rather than the one you 
selected in the Preferences dialog box.

Q. Why do I get a blank image or an image with missing parts when I convert a WMF file to CGM?
A. Your WMF image probably contains primarily raster information. HiJaak Express does not support 

raster information in CGM files, so only the vector portions are being saved in the CGM file. 



FAX

Q. Why doesn’t my fax format show up in the Files of Type lists? 
A. To read a file in a supported fax format, you must register it with HiJaak. You can do this in the Formats

dialog box. For instructions, click the following: To change or add format extensions
You can also register the default format extension for all fax formats. All fax formats will be configured 
to 5 inches. If you want to register all fax formats, click here, 



GEM

Q. Why does my conversion to GEM create an image with incorrect colors?
A. The GEM format uses a fixed color palette, so conversions from formats without the same palette 

limitation may produce undesired color changes in GEM. To remedy this problem, use HiJaak 
Express's Change A Color option under the Colors menu to remap colors in the source image to the 
desired colors in the fixed GEM palette.



EMF

Q. Why can’t I process (change colors, grayscale, invert colors, etc.) an EMF file that HiJaak 
Express creates from any raster file?

A. There are some limitations to HiJaak’s support of raster components in metafiles. If you need to save a
file in EMF format and perform processing options, process the original raster image first, then save it 
in EMF format.



EPS

Q. Why does HiJaak create a blank image when I convert to EPS?
A. If you are converting a metafile to EPS, HiJaak Express will create a blank file because it does not 

support metafile to EPS conversions. You can convert either raster or vector images to EPS; and you 
can open metafile EPS files; but you cannot create a metafile EPS image. If you need to convert a 
metafile image to EPS, first save it to a raster or vector format, then convert the raster or vector image 
to EPS format. 



ICO

Q. Why don’t any of my icon files created by HiJaak Express import into any of my applications?
A. HiJaak Express can create two types of icon files: 16 color and 256 color. Windows 3 applications 

support 16 color icons only, and although Windows 95 and NT 4.0 support 256 color icons, not all 
Windows 95 and NT 4.0 applications do. By default HiJaak Express creates Windows 95 and NT 256 
color icons. If you find that your applications won’t import an icon file created by HiJaak Express, 
reconvert the file and in the Processing Options dialog box, pull down the Flavors list and select 
Windows 3. HiJaak Express will generate a 16 color icon file that should import into any application 
that supports ICO.

Q. Why doesn’t HiJaak Express create thumbnails of ICO files?
A. Although HiJaak Express supports Icon *.ICO files, by default, it does not create thumbnails of them 

because Windows display these thumbnails by default. 



JPG

Q. Why does the quality of my image degrade when I convert to JPG?
A. JPEG uses a “lossy” compression scheme. This means that JPG trades smaller file size for quality. If it

is important for you to create a high quality JPEG image from your conversion, click the Options button
in the Save As or HiJaak Convert dialog boxes during the conversion. The Processing Options dialog 
box displays. Drag the Quality slider to the left, toward “High.” Click OK to exit the Processing Options 
dialog box.



TXT

Q. Why doesn’t HiJaak Express create thumbnails of TXT files?
A. Although HiJaak Express supports ASCII TXT files, it does not thumbnail name. By default, it maintains

the TXT icon association with Notepad. 

Q. Conversions of Text files to CGM result in a zero-length file or an empty image. What can I do to
get a successful conversion of TXT to CGM?

A. Text to CGM conversions produce blank images or zero-length files when the conversion is done with 
the Stroke Fonts option set to On. To correct the problem, de-select the Stroke Fonts option.

Q. I can’t read any of the TXT files I open. How can I make the text larger and more readable?
A. The text becomes difficult to read because HiJaak Express may be scaling it. Pull 

down the View menu and point to Auto Scale; click Page in Width. The display
should become much easier to read. Also, you can change the background color. 
Select Setup, Preferences, Background, and change to another color.

Q. Why do conversions to TXT often result in blank images?
A. The TXT format only supports text objects. If your source image does not contain any text, then a 

conversion to TXT as a destination will produce a blank image.

Q. Why can’t I open my TXT files in a text editor after editing them with HiJaak Express?
A. When you open a TXT file in HiJaak Express and then edit it by rotating, flipping, cropping or in other 

ways, HiJaak Express strokes the fonts. That is, the text becomes rasterized lines and circles, rather 
than ASCII encoded letters. Therefore, your text editors will not be able to read the files any longer. We
recommend that you never edit important text files using HiJaak Express’s Edit or Colors menus. 



 General conversion problems
Q. When I try to convert a file, HiJaak Express goes into an endless loop and I have to reboot. 

What can I do to prevent this?
A. HiJaak Express will go into an endless loop if the buffer size is less than one scanline of data. To fix 

this problem, pull down the HiJaak Express Setup menu and select Preferences. You will see the 
Preferences dialog box. In the Buffer Size area, increase the current value. For example, if your 
current buffer size is 16,000, enter 20,000 and try the conversion again. You can increase your buffer 
size up to 64,000.

Q. Why doesn't HiJaak Express create files with the right number of colors when I convert from a 
vector to a raster format?

A. When you are converting from a vector to a raster format, HiJaak creates a file with the same number 
of colors as the display mode you are using in Windows. For example, if Windows is running in 8-bit 
mode, HiJaak Express will create 8-bit destination files (256 colors), regardless of the number of 
colors in your source file. If you need to convert high color source files to high color destination files, 
you need to change your Windows display mode through the Control Panel. Most graphics cards offer 
both a high resolution, lower number of colors, and a high-color, low resolution display mode. Select 
the display mode with higher number of colors and a lower resolution and convert your files.



Error Messages

The following are some of the most common error messages in HiJaak Express. Click on the error that 
you need help correcting.
Warning 2 --   PCL  :   The Source could be in PCL 5
Warning 8 --   GIF  :   This image may contain text that cannot be displayed.
Error -- 101: Couldn't allocate virtual memory.
Error -- 250: General open error.
Error -- 298: Resource was not found. Please reinstall.
Error -- 1002: Source file type is unsupported.
Error -- 1003: Source file doesn't match type. Different flavor.
Error -- 1007: Insufficient memory. Further results may be unpredictable.
Error -- 1017:    Source corrupted or file type or version unsupported.
Error -- 1025: Internal error.
Error -- 1036: Missing a DLL.

Q. Why does HiJaak Express display error messages when I have the Show Warnings Check box 
deselected?

A. The Show Warnings option toggles the display of warning messages, not error messages. When 
HiJaak Express encounters an error, it will not be able to continue processing and will display a 
message. When it encounters a warning, it can continue processing, but the results may not be as you 
expect.



 Warning 2: This warning appears if HiJaak Express detects information in the file that may be PCL 5. 
Certain elements are the same in both PCL 4 and PCL 5 files; however, HJDT only supports PCL 4 files. If 
the conversion fails or is inaccurate, it may be because the file contains PCL 5 information.



    Warning 8: This warning indicates that text in the GIF file may not appear when the file is opened. This 
refers to ASCII text, as opposed to text that has been rasterized and is part of the raster image. The file 
will still open.



Error 101: This error occurs if there is no more space on your hard drive for temporary files. Free hard 
disk space by deleting or moving files from the hard drive.



Error 250: General open error. HiJaak Express cannot open the file you have selected. This may happen 
if the file is in use by another application or open by another user. If the file is not locked by another user, 
make sure there is not an error on the disk where the file resides. To check the disk, run Windows 
ScanDisk program.



Error 298: If HiJaak Express is missing a resource file, it will not run. You must reinstall to add that file. 



Error 1002: This error occurs if the file extension is not recognized by HiJaak Express. If HiJaak Express 
doesn't recognize the extension, it will not open the file. If you know the file type, check the Supported 
Formats in the HiJaak Express User Guide to see if it is supported. If the file type is supported, you can 
change its extension, thereby allowing HiJaak Express to open it: rename the file using HiJaak Browser 
and give it an extension that HiJaak Express will recognize. If the file still does not open, it is probably not 
in a supported format.



Error 1003: This error may occur for one of the following reasons:
The file type may be different from that which is indicated by the extension. HiJaak Express 
assumes that the file extension of a file represents the actual file type. However, this may not always be 
the case. If a file has an extension that does not represent the file type, HiJaak Express will not read the 
file correctly and you will receive this error. You need to find out how the file was created in an effort to 
discover the file type. When you discover the file type, check the Supported Formats in the HiJaak 
Express User Guide to see if it is supported. If the file type is supported, you can use HiJaak Browser to 
change its extension, thereby allowing HiJaak Express to open it.
The file may be corrupt. Check the file by opening it in another application. If the file does not open, 
it is probably corrupt. If it does open, the file type is probably different from what is indicated by the 
extension. You need to find out how the file was created in an effort to discover the file type. For example,
the file may have been saved with the wrong extension. When you discover the file type, check the 
Supported Formats in the HiJaak Express User Guide to see if it is supported. If the file type is supported,
you can use HiJaak Browser to change its extension, thereby allowing HiJaak Express to open it.



Error 1007: If HiJaak Express detects that both physical and virtual memory are below 10%, it will display
this message. HiJaak Express needs at least 10% of memory to function as designed. To overcome this 
problem, close any unused applications and close any images in HiJaak Express that you can. Although 
closing the applications and images should free enough memory for HiJaak Express to continue, we 
recommend that you also save your work and restart HiJaak Express before continuing.



Error 1017: HiJaak Express cannot open the file you have selected. The file may be corrupt; try to open it
another application that supports files of this type to determine if it is corrupt. It the other application can 
open it, then HiJaak Express may not support this particular variation, or flavor, of the format. If you want, 
you can use this other application to export the file to a type that HiJaak Express can read. There is no 
other workaround. We encourage you, however, to contact IMSI Technical Support and forward the 
problem file and error message to them, so we can improve HiJaak to handle files of this type in future 
updates.



Error 1025: This error may occur if the settings are corrupt. If you receive this error, you need to load the 
default HiJaak Express settings. Select Load Defaults from the Setup menu.



Error 1036: If HiJaak Express is missing a DLL, it will not run. You must reinstall to add that DLL.





Basic look of an image

Problems with the Way Your Image Looks
If your opened, processed or converted image doesn't look the way you expect it to, there may be a way 
to fix it. Click on one of the following topics for more information.

 Parts of my image are missing
 My rotated image doesn't look right
 I can’t crop my image

Note: If your image looks bad after performing multiple processing operations on it, try saving and re-
opening the image between each operation.



Parts of my image are missing

Q. Why are some elements of my vector image missing?
A. If elements (lines, arcs, etc.) the same color as the background are not visible, use Reveal 

Background Color Objects to restore the image. This option sets initially invisible objects to a color 
that contrasts with the background.

Q. Why does changing my color raster image to black and white (Number of Colors=2) result in 
the loss of part(s) of the image?

A. If you try to force a raster image to black and white, it may appear to lose some part(s) of the image, or
even result in an all black or an all white image.    This may indicate that HiJaak Express's selection for
what colors to make black and what colors to make white is inappropriate for the image you are 
working with.    Use the Change a Color option from the Colors menu to manually change your colors 
to the appropriate black and white output.    HiJaak Express remembers your color changes, and gives 
you the option to apply them in future similar conversions.



My rotated image doesn't look right

Q. Why does my image keep getting smaller the more I rotate it?
A. When you rotate an image, HiJaak Express adds padding around the image to allow it to fit in a 

rectangular window. As you continue to rotate, more and more padding is added, which causes the 
image to shrink. If you don’t want this to happen, select Edit\Undo after each rotate, and then 
increase the rotation angle the desired amount in the Rotation Options dialog box.

Q. After I rotate my PCL file, why do my fonts change?
A. The PCL4 used by HiJaak Express in emulation of the LaserJet II does not provide for the rotation of 

fonts. HiJaak Express substitutes an already-rotated font whenever text in a PCL file is rotated. That 
may cause the look of the PCL file to change. To avoid the change in font, convert the PCL file to PCX 
and then back to PCL. The conversion through PCX will cause text to become bitmapped 
representations of the original font. Subsequent rotation of the PCL file will not change the appearance
of the text.

Q. Why won’t my PCL files rotate?
A. This is a known bug. We are working on a fix.

Q. Why does a colored background appear when I rotate an image after using the Optimize Palette
option on it?

A. When an image is rotated a number of degrees that is not an even multiple of 90, the resulting image 
will no longer fit into the rectangular window available for it. HiJaak Express must pad the image with 
pixels of a certain color to fill out the rectangular window. Whenever possible, HiJaak Express will fill 
out the image with the background color selected under Setup and Preferences. However, if palette 
optimization is used on an image before rotation, the optimization may, in fact, eliminate the 
background color from those available for the particular image. Another background color -- one that is
available in the new optimized palette -- is selected to fill out the image window. To ensure that no 
color substitution takes place, rotate the image before selecting optimize palette. Performing the 
rotation first will introduce the background color into the image and it will be preserved as part of the 
palette through the optimization process.



I can’t crop my image

Q. Why can’t I crop any of my PCL files?
A. This is a known bug in this version of HiJaak Express. We are currently working on a fix.



Macintosh Files

Moving Graphics Files from the PC to the Macintosh
Moving files to the Macintosh can be done in several ways. The following procedure is one way that only 
uses software provided with the Macintosh itself. If you plan to do a large amount of file transfer between 
platforms, an Apple dealer can recommend software that will automate this process. 

If you have successfully moved the file to the Macintosh, but cannot open it in your application, you may 
need to change the file's type code. For more information, click on the following:
Changing a File's Type Code

Move the file onto the Macintosh Hard Disk as Follows:
1. Create a file using HiJaak which is compatible with the application in which you plan to use it. If you are

not sure which format to use, PICT (.PCT) and TIFF (.TIF) are two of the most common formats used 
in Macintosh applications.    Please note that there are several different flavors of both PICT and TIFF, 
and some may not be compatible with applications that read those formats.    

2. Copy the file to a DOS formatted 3.5" floppy disk.
3. Take the floppy to the Macintosh. Before inserting the disk in the Macintosh, run the Apple File 

Exchange program.
Note: Apple File Exchange is a program that allows certain Macintosh floppy drives to read and 
write PC disks. If you do not have this program on your System disks, contact your Apple dealer 
to check the compatibility of your Macintosh drive.

4. Once Apple File Exchange is running, insert the floppy in the Macintosh. The program window will be 
split into two parts:    one for the floppy and one for the Macintosh. First, select the folder on the Mac 
disk in which you want to copy the file. Next, select the file from the PC disk to be copied, and click the 
Transfer button in the middle. Once you are finished copying files, click the Eject button to eject the 
disk, then select File/Quit to close Apple File Exchange. Your file should now be on the Macintosh hard 
drive.

You should be able to open this file in your application. If the file does not show up in the application's 
Open dialog box, you will need to edit the file's type code to make it compatible with your application. 
For instructions on editing a file's type code, click on the following:
Changing a File's Type Code



Changing a File's Type Code

This procedure described how to edit a file's type code to make it compatible with your Macintosh 
application. Use this procedure if you have transferred a file to the Macintosh, but are unable to open it in 
your application.

Change a File's Type Code on the Macintosh as Follows:
1. Copy the file from the floppy to a Mac hard disk. 
2. Open ResEdit. This is a utility distributed by Apple. It comes on certain versions of the Macintosh 

System disks. If you do not have it, contact your Apple dealer. There are other utilities that can also 
change a file's Type code. If you'd prefer to use one, consult the program's documentation and the 
table of Type codes shown in step 3 below.

3. In ResEdit, select File/Open. Select the name of the file you want to work on, then Click OK. If ResEdit 
asks for confirmation about adding a resource fork to the file, click OK. The resource fork is needed for 
the file to work in some Macintosh applications.

4. Select File/Get Info for filename. This will bring up a box which contains information about the file and 
two text fields named Type and Creator. Highlight the text in the Creator field and delete it, leaving the 
field blank.    For the Type code, delete the text in the field and replace it with the appropriate code from
the list below. Note that all codes must be in all uppercase and have no spaces.

If the file is a the correct Type code is...
TIFF (*.TIF TIFF
PICT (*.PCT) PICT
EPS (*.EPS, *.AI) EPSF
MacPaint (*.MAC) PNTG

        Once the codes are correct, select File/Save, then File/Exit. The file should now show up in your 
application's Open dialog box and be readable in your application. If you have a file whose Type code 
is not listed above, create a file of the same format in your application, and follow steps 1-3 above. 
Instead of changing the Type and Creator codes, however, note the Type code and then select File/Exit
without changing anything. That Type can then be used when working on file of that format from the 
PC.



Printing

For tips on getting better results printing in HiJaak Express, click one of the following:

 Black and white print-outs of color images
 General printing tips
 Printing errors



General printing tips
Q. What scaling options should be used on my image to ensure the best quality printing?
A. When scaling an image for printing, select horizontal and vertical resolutions that match those of your 

print device. If the image was to be printed on a typical laser printer, for example, the resolutions 
should be set to 300. After setting the appropriate resolutions, the width and height fields should be 
filled in with the dimensions desired in the printed output. Selecting Maintain Aspect Ratio will ensure
that the proportions of the original image are preserved while the image is being scaled.



Printing Errors

Q: Why do I get a blank page when I print from HiJaak Express?
A: This error might occur if your HiJaak Express settings have been corrupted. When this occurs, close 

the image you are trying to print and reload the default set file by pulling down the    Setup menu and 
selecting Load Defaults. Restart HiJaak Express.

Q: Why doesn’t HiJaak Express save the paper orientation setting?
A: HiJaak Express saves only HiJaak print settings. The paper orientation is a printer setting. If you want 

to change the paper orientation permanently, you need to change your printer setup.



Scaling and Resizing

For tips on scaling and resizing your images in HiJaak Express, click on one of the following:

 Changing the size of an image
 Preventing distortion while scaling or resizing
 Getting the best print-outs when scaling



Changing the size of an image

Q. Why isn’t the Resize command available for my vector and metafile images?
A. Vector and metafile images consist of mathematical instructions for how to create objects. Since the 

objects themselves don’t have a set size, they will size and scale automatically as you change the size
of the image window. 

Q. How can I scale an image to be two or three times the size of the original?
A. HiJaak Express allows for this type of scaling through the Multiples selection under Units in the 

Resize dialog box. Once Multiples is set as the unit of scaling, the image will be scaled a number of 
times equal to the values placed in the width and height fields. For example, entering 2 in the width 
field and 2 in the height field will produce an image that is double the size of the original.

Q. How can I size an image to match the dimensions of my screen?
A. Selecting Fit in Display Width from the Resize dialog box will scale your image to be precisely as 

wide as your display screen. It will preserve the proportions of your original image. Selecting Fit in 
Display will scale your image to be precisely as wide and as tall as your display screen. If necessary, 
this scaling option will distort the width to height proportion of the original image.



Preventing distortion while scaling or resizing

Q. How can I prevent stretching or squashing of my image when I resize it?
A. Stretching or squashing of an image may occur when the height and width values entered by the user 

are not in the same proportion as the width and height of the original. The Maintain Aspect Ratio 
selection on HiJaak Express's Resize dialog box ensures that the proportions of the original image are
preserved during scaling.



Getting the best print-outs when scaling

Q. What scaling options should be used on my image to ensure the best quality printing?
A. When scaling an image for printing, select horizontal and vertical resolutions that match those of your 

print device. If the image was to be printed on a typical laser printer, for example, the resolutions 
should be set to 300. After setting the appropriate resolutions, the width and height fields should be 
filled in with the dimensions desired in the printed output. Selecting Maintain Aspect Ratio will ensure
that the proportions of the original image are preserved while the image is being scaled.



Text and Fonts

For advice on dealing with known problem areas related to text and fonts in HiJaak Express, click on one 
of the following:

 I'm having problems with fonts in my PCL files
 Text in my ASCII TXT file looks wrong



I'm having problems with fonts in my PCL files

Q. Why does my PCL image have incorrect fonts? What does the Font File Not Found error 
message mean?

A. A PCL 4 file, such as those supported by HiJaak Express, generally contains all information that a 
LaserJet II compatible printer will require for accurate printing and will show up with correct fonts in 
HiJaak Express. However, some applications keep important font information separate from the 
document information. Those applications will produce incomplete PCL files that will probably not 
function as expected in HiJaak Express and may cause a Font File Not Found error message during 
conversion. For these PCL files to function properly, it is important to open the Source PCL Options 
screen at the beginning of a PCL conversion and download the appropriate font files into HiJaak 
Express. It is important to note that downloading of fonts into HiJaak Express will usually not be 
required for a successful PCL conversion as fonts are typically included in the PCL file itself.

Q. How can I avoid the change in font that occurs when I rotate my PCL file?
A. The PCL4 used by HiJaak Express in emulation of the LaserJet II does not provide for the rotation of 

fonts. HiJaak Express substitutes an already-rotated font whenever text in a PCL file is rotated. That 
may cause the look of the PCL file to change. To avoid the change in font, convert the PCL file to PCX 
and then back to PCL. The conversion through PCX will cause text to become bitmapped 
representations of the original font. Subsequent rotation of the PCL file will not change the appearance
of the text.



Text in my ASCII TXT file looks wrong

Q. When I am viewing an ASCII TXT file, the font in my TXT file is incorrect and extends beyond 
the border of the window.    How do I correct this?

A. Your settings have probably been corrupted. Pull down the Setup menu and select Load Defaults. 
Restart HiJaak Express and open your TXT file again.

If this doesn't work, check in the Windows Control Panel Font utility to make sure you have TrueType 
fonts enabled. If they are not, enable them and try again.



Catalogs and Updates

Click the topic about which you need answers or advice:

Thumbnails and File Properties
HiJaak Catalog Controls: HiJaak Update, SHCENTER.EXE and the task tray globe icon
Catalog Errors



HiJaak Thumbnails and File Properties
Q. How can I easily remove a range of thumbnails from the catalog?
A. In the HiJaak Catalog Setup Catalogs page, you can press the Ctrl key as you click each thumbnail 

you want to remove, and then you can click the Delete button. To delete a range of thumbnails, run 
Explorer and open the folder from which you want to remove thumbnails. Press the Shift key as you 
click the first and last thumbnail in the range you want to remove. Then click the secondary mouse 
button and select Remove from Catalog from the shortcut menu. You can also use the Remove from 
Catalog command from the shortcut menu of folders in Explorer.

Q. Why do I have thumbnails for BMP that I haven’t updated and why do they paint slowly?
A. Windows can also create and display thumbnails of BMP files. Your Windows is probably set up to do 

this. 
If you just want HiJaak Express to create and display the thumbnails rather than Windows, you can 
run HiJaak Update on your BMP files. 
If you don’t want Windows to create or display thumbnails of BMP files at all, regardless of whether 
you want HiJaak Express to create and display thumbnails, you need to change your Windows registry
file. To edit the registry file to prevent Windows from creating or displaying thumbnails of BMP files, 
click here: .
To switch back to Windows icons, click here: .
Note that before you see the effect of this change, you may have to clear the Windows Explorer 
cache. Click here for instructions: Clearing the Windows Explorer Cache.

Q. Why have my HiJaak Express thumbnails disappeared from Explorer and where is my HiJaak 
Update icon that used to be in the tasktray?

A. Somehow HiJaak Catalog has become disabled. Run the HiJaak Catalog Setup. Select the Setup 
page and make sure that Enable HiJaak Shell Extensions is selected. If the HiJaak Shell Extensions
are not enabled, you will not be able to use thumbnails, shortcut menu items, or catalogs.

B. If your only problem is that you can’t see thumbnails, try switching Explorer into Large Icon or    HiJaak 
Extra Large Icon mode. HiJaak thumbnails do not display in Small Icons or Details mode. If you still 
don’t see any thumbnails, run HiJaak Catalog Setup and make sure you have the correct catalog open
and it contains the thumbnails you expect to see. 

Q. Why aren't thumbnails updating properly? When I delete thumbnails from the catalog, they still 
appear in Windows Explorer, and when I modify a file and try to update the thumbnail, it 
doesn't change.

A. Windows Explorer stores some thumbnail information in memory, so it does not always display the 
changes right away. Try manually updating the thumbnail by selecting HiJaak Update from the shortcut
menu. If this doesn't work, restart Windows. 
If restarting Windows doesn’t work, you may need to clear the icon cache. For more information, click 
here: Clearing the Windows Explorer Cache



HiJaak Catalog Controls: HiJaak Update, SHCENTER.EXE and the task tray globe 
icon
Q. I don’t want to use HiJaak Express’s shell extensions, catalogs or thumbnails. I only want to 

use the main HiJaak Express application. How can I prevent the shell extensions from 
appearing?

. Run HiJaak Catalog Setup. Select the Setup page and deselect Enable HiJaak Catalog. To disable 
shortcut menu items, you must also deselect each check box in the HiJaak shortcut menu items 
group box.

Q. Shell extensions have been causing problems on my system that are preventing me from even 
rebooting Windows. The only way I can start Windows is in Safe Mode? How can I fix this 
problem?

A. The shell extensions may cause this problem on a very small percentage of systems. With Windows 
booted in Safe Mode, run HiJaak Catalog Setup. Select the Setup page and deselect Enable HiJaak 
Shell Extensions. To disable shortcut menu items, you must also deselect each check box in the 
HiJaak shortcut menu items group box. You will not have access to shell extensions anymore, but 
your previous problem with Windows should be fixed. Do not rerun SHCENTER.EXE. 



Catalog Errors

Q. I just got an Error 1004: Catalog Corrupt error. What can I do?
A. The catalog can become corrupt because you rebooted without using Window's Shut Down procedure.

However, you may be able to recover your catalog file by forcing HiJaak Catalog Setup to rebuild some
of the catalog files.

1. Run HiJaak Catalog Setup and click the Catalogs tab.
2. In the Catalogs tab, open another catalog you have created (one that is not corrupt), or create 

a new catalog. This catalog does not have to contain any files.
3. Close HiJaak Catalog Setup.
4. Run Explorer and switch to the folder where the corrupt catalog is located. If it is the default 

catalog, it will be located in C:\Program Files\IMSI\HiJaak Express\Catalog.
5. In this folder delete all CATALOGNAME.I* files. 
1. Run HiJaak Catalog Setup again and try to open the originally corrupt catalog. If it opens 

successfully (with no errors), your catalog has been successfully recovered. If you get an 
error message, then the catalog has been damaged to the point that it is unrecoverable.



Clearing the Windows Explorer Cache

To save time, Windows Explorer keeps some information in memory. One of the items that it keeps in this 
“cache” is icon appearance. When you change the appearance of your icons, the icons may not show the
change right away because Windows is “remembering” the previous appearance of the icons and not 
repainting them. You can force Windows Explorer to clear this icon cache by forcing it to redraw icons. An 
easy way to do this is to change your icon size:
1. Click the secondary mouse button on the Windows Desktop and click Properties.

The Display Properties sheet displays.
2. Click the Appearance tab.
3. Pull down the Item drop down list and click Icons.
4. In the Size field increase or decrease the size and click Apply.

Windows redraws all icons at the new size.
5. If you want to change the size back, you can do so.
6. Click OK.



Viewing

Viewing images



Viewing Images

Q. Why does HiJaak Express lock up when opening some of my images?
A.    This condition results from a low amount of available memory. A low memory condition is probably the

result of Windows Explorer's memory caching. An easy way to clear out Explorer's cache is to change 
the size of the icons displayed in Windows: Open the Windows Control Panel and select Display. Click
on the Appearance tab. Pull down the Item drop-down list and click on Icon. The Size field becomes 
enabled. Click in the Size field and type a different size at which to display your icons. Even a 
difference of 1 or 2 pixels will work. Click on Apply. You can change the icons back to their original 
size at any time. Click on OK. Also, ensure that you have enough space on the drive HiJaak is 
installed on.

Q. Why does HiJaak Express dither my images?
A.    When you use a 256-color display mode, HiJaak Express uses a fixed palette to display images. This

fixed palette dithers images. The dithering affects only the image display, not the image's output quality
(printing or converting). If you don't want HiJaak Express to dither your images, use the Control 
Panel's Display icon to switch Windows into a higher color mode.



HiJaak Express and Windows Applications

Q.      Adobe Photoshop can’t read any of the AI files I create with HiJaak Express. What should I 
do?

A.     When converting a file to AI, select the Options button. In the Processing Options dialog dialog box, 
pull down the Flavors list and select Adobe Photoshop. Click OK and continue with the conversion. 
Photoshop should have no problems reading the files created.

Q.      How can I associate a HiJaak-supported format with another application?
A.     In Explorer, highlight a file in the format that you want to reassociate. Press Shift+F10. You will see 

the file's shortcut menu with the option Open With. Select Open With and select the application with 
which you want to associate the format (file extension). Click on OK. 



System Problems

Q. Now that I have installed HiJaak Express, my backup software doesn’t work. How can I do a 
system backup now?

A. When you start Windows, HiJaak Express automatically loads its catalog, but some backup software 
does not work properly when files are in use. To back up your system, you need to unload the catalog. 
Run HiJaak Catalog Setup and select the Catalogs tab. In the Catalogs page, click the Catalogs List 
button; the Catalogs List dialog box displays. In this dialog, click the Don’t Load Any Catalogs on 
Startup radio button and click OK. Close HiJaak Catalog Setup and restart your computer. Your 
backup software should work properly now.

Q. What can I do when my system hangs when I try to open or zoom a vector image? 
A. This problem is related to your video card and display. Open the Control Panel and double click the 

System icon. In the Performance tab, click the Graphics button and set the graphics acceleration 
options to a lower setting and try again. Keep decreasing this value until you no longer have the 
problem.

Q. Now that I’ve installed HiJaak Express, I can’t even reboot Windows without going into safe 
mode. What should I do?

A. The shell extensions may cause this problem on a very small percentage of systems. This 
is a known bug in HiJaak Express and we are working on a fix that will be made available 
to you as soon as possible. Until then, with Windows booted in Safe Mode, run REGEDIT. 
Then search for the key HKEY_CURRENT_USER\Software\Microsoft\Windows\
CurrentVersion\Run.
Click the secondary mouse button over the value SHCenter.EXE and/or RUNNER.EXE and 
select Delete. Reboot Windows.

Q.      Now that I have installed HiJaak Express, I sometimes cannot switch between Norton 
desktops. What should I do?

A. Close down HiJaak Express. Press Ctrl+Alt+Del to view a task list in Windows. Look for the program 
LOCO.EXE. Select it and click End Task. If there is more than one, end them all. Your system should 
return to normal.



Scanning (HiJaak Scan)

Q. Why doesn’t my scanner work with HiJaak Scan? 
A. If you installed your scanner after you installed HiJaak Express, then your scanner may have 

overwritten important TWAIN files with older versions. To replace the old files with the newer versions 
shipped with HiJaak Express, run HiJaak Setup from the HiJaak Express folder in the Start menu. 
Reboot your computer and try again.

Q. Why doesn’t my Microtek scanner work with HiJaak Scan? 
A. If you are having problems with Microtek’s scanners, see 

HTTP://www.mteklab.com/tech/PCFiles/default.html for special versions of the TWAIN files that might 
fix the problem.



Installing and Setting Up HiJaak Express

Q. Why is HiJaak Express displaying an error message when I try to uninstall it using the Control 
Panel’s Add/Remove programs applette?

A. If you have run uninstall and canceled out of it several times, or have deleted critical files from the 
HiJaak Express\BIN directory, some files that are necessary to help remove the entire program may be
missing. Use Windows Explorer to delete the HiJaak Express directory and all of its contents to remove
the HiJaak Express program files. If you need to remove every trace of HiJaak Express, you can either 
copy the contents of the CD directory to the HiJaak Express\BIN directory on your hard drive, or you 
can reinstall HiJaak Express. This will restore those critical files that have been deleted. After restoring 
the HiJaak Express files that are were missing, you can run the uninstall program again.

Q. The first screen in the install indicated that I would have to reboot after the install finishes; 
however, the install appears to be complete, but it never prompted me to reboot. Is something 
wrong?

A. If you are reinstalling HiJaak Express or installing an upgrade of HiJaak Express, and you have 
background update running, the install will not prompt for a reboot. Before installing an update make 
sure background update is not running. Click the secondary mouse button on the green ball icon in the 
task bar and select Setup Update. In the Update Time area, click the Disable All Automatic 
Updating radio button and click OK. 




